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De acordo com o comando a que cada um dos itens a seguir se refira, marque, na folha de respostas, para cada item: o campo designado
com o codigo C, caso julgue o item CERTO; ou o campo designado com o codigo E, caso julgue o item ERRADO. Para as devidas
marcagdes, use a folha de respostas, inico documento valido para a corre¢fio das suas provas.

Texto para os itensde 1 a 17
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A violéncia instalada nas grandes cidades levou
muitos brasileiros a fazer o caminho oposto ao dos
antepassados. Em busca de melhor qualidade de vida, eles
abandonaram as capitais e os centros urbanos. Instalaram-se em
urbes do interior que, ao longo dos tUltimos anos, atrairam
investimentos e ampliaram o mercado de trabalho. Ali, os
novos moradores poderiam usufruir do conforto urbano aliado
a tranquilidade decorrente da garantia de seguranga.

Levantamento do Mapa da Violéncia mostrou que o
cendrio pacifico ficou no passado. Divulgado no dia 30 de
margo pelo Instituto Sangari, o documento prova que a
criminalidade mudou de enderego. Migrou das capitais e
regides metropolitanas para o interior. Em 10 anos, cresceu o
numero de homicidios. Em 1997, a média era de 13,5
assassinatos para cada grupo de 100 mil pessoas. Em 2007, a
cifra saltou para 18,5.

Mais: os dados reforgam tendéncias que vém causando
crescente apreensdo as autoridades atentas a evolugdo do perfil
da violéncia no pafs. Um deles: aumenta o nimero de
homicidios entre jovens. Em 1980, eram 30 casos para cada
100 mil habitantes. Em 2007, nada menos que 50,1. Outro:
homens sdo vitimas preferenciais — 90% das ocorréncias.
Mais uma: os negros lideram o ranque dos mortos —
incremento de 21% em relagdo as estatisticas dos periodos
anteriores.

As informagdes do Mapa da Violéncia permitem
extrair conclusdes e sugerir medidas. “O sapo”, escreveu
Guimarges Rosa, “ndo salta por boniteza, mas porém por
precisdo”. O mesmo ocorre com a bandidagem. Criminosos
buscaram novos abrigos porque os antigos ndo mais lhes
oferecem as condi¢des de que precisam. O Plano Nacional de
Seguranga Publica ¢ o Fundo Nacional de Seguranga
eficazes que dificultaram a

implementaram agdes

movimentagdo do crime organizado. Entre elas, o
aparelhamento dos sistemas de seguranca publica nos grandes
conglomerados.

O combate a malfeitores ndo se deve restringir as
metropoles. Deve, para atingir o fim a que se propde —
erradicar o crime ou reduzir os casos a niveis civilizados —,
estender a guerra aos novos territorios. Além de medidas
repressivas, impdem-se iniciativas preventivas. Sem isso, 0s
novos mapas a serem divulgados nos proximos anos mostrardo
atroca de seis por meia duzia. Em vez de diminuir a ocorréncia

nacional do crime, indicardo apenas a mudanga de enderego.

Crime muda de endereco. /2 Correio

Braziliense, 1.°/4/2010, p. 22 (com adaptagbes)

Julgue os itens que se seguem, relativos as ideias do texto.

De acordo com o texto, cidades pequenas sdo locais atraentes
para investidores e oferecem amplo mercado de trabalho.

O nivel de criminalidade cresceu nas cidades interioranas em
virtude das dificuldades encontradas, nas grandes cidades,
pelos transgressores da lei.

De um lado, o cendrio atual da violéncia tende a piorar a
vulnerabilidade de trés grupos sociais: o dos jovens, o dos
homens e o dos negros; de outro lado, esse fendmeno deve
levar & diminuic&o de atos violentos contra as mulheres.

O texto mostra que o crime organizado nas metropoles
diminuiu desde que o Plano Nacional de Seguranga Publica e
o Fundo Nacional de Seguranga puseram em pratica medidas
coercivas.

Segundo o texto, impedir os crimes previamente é uma medida,
no minimo, tdo necessaria quanto repreender 0s criminosos.

Com relagdo a estrutura do texto, julgue os proximos itens.

Com excecio de “atrairam” (£.5) e de “ampliaram” (£.6), todas
as formas verbais do primeiro pardgrafo fazem referéncia a
“muitos brasileiros” ({.2).

Os termos “Um deles” (0.19) e “Outro” (£.21) referem-se a
“os dados” (¢.17).

Os termos “antigos” (0.30) e “grandes conglomerados”
(0.35-36) retomam a ideia de “as capitais ¢ 0s centros
urbanos” (0.4).

O trecho “estender a guerra aos novos territorios” (£.40) pode
ser alterado para estender os novos territorios a guerra sem
se prejudicar a correcdio gramatical e o sentido original do
periodo.

Com relagdo & pontuagdo empregada no texto, julgue os itens

seguintes.

10

1"

12

Na linha 3, a substituigdo do ponto que finda o primeiro
perfiodo por dois-pontos mantém a corregdo gramatical do
texto, desde que se altere a inicial de “Em” para mintscula.

Na linha 5, do ponto de vista gramatical, seria correto o
deslocamento da virgula que sucede a palavra “que” para
imediatamente apds o vocdbulo “interior”.

A corregdo gramatical do texto seria mantida caso o trecho
“Divulgado no dia 30 de margo pelo Instituto Sangari”
(€.10-11) fosse deslocado para depois da expressdo
“o0 documento” (£.11) da seguinte forma: O documento

divulgado no dia 30 de margo pelo Instituto Sangari.
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Com referéncia a concordancia e & regéncia verbal e nominal
empregadas no texto, julgue os itens a seguir.

13 Nalinha 17, a locugdo “vém causando” apresenta concordéncia
de nimero com o seu respectivo sujeito, “os dados”.

14 No trecho “vém causando crescente apreensdo as autoridades”
(0.17-18), a ocorréncia do acento grave deve-se a regéncia de
“apreensfo”.

15  Em “autoridades atentas a evolugdo do perfil da violéncia no
pais” ({.18-19), o termo “a” poderia ser substituido, sem prejuizo
gramatical ou de sentido para o texto, por para a.

Com referéncia ao vocabuldrio do texto e a ortografia, julgue os itens
subsequentes.

16 No texto, a expressdo ‘por precisdo’ (£.28-29) apresenta sentido
equivalente a com perfeicéo.

17 A substituicdo do vocabulo “malfeitores” (0.37) por celerados
mantém o sentido do texto.

Julgue os itens seguintes, relativos a redagdo de correspondéncias
oficiais.

18 Os principios que regem a redagdo de correspondéncias oficiais
favorecem a existéncia de uma tnica interpretagdo para o texto
do expediente, assim como asseguram impessoalidade e
uniformidade no trato dos assuntos concernentes aos Orgéos
governamentais.

19 O nivel de linguagem utilizado em atos e expedientes oficiais
encontra justificativa no seu carater publico e no fim a que eles se
destinam, além da obrigatoriedade de que sejam inteligiveis para
qualquer publico.

20 Um texto de redacdo oficial deve ser redigido com vistas a evitar
a prolixidade.

frequéncia

quantidade de acessos (x 1.000)

Certa empresa, em determinado més, realizou levantamento acerca da
quantidade didria de acessos simultdneos ao seu sistema, cujo
resultado ¢ mostrado na figura acima. A partir das informagdes
apresentadas nessa figura, e considerando que a distribuicdo da
quantidade didria de acessos simultdneos ¢ representada pela
variavel XX, julgue os itens que se seguem.

21 A quantidade de 6 mil acessos simultdneos por dia representa a
moda de X.

22 O més em que esse levantamento foi realizado possui mais de
30 dias.

23 A quantidade de 2.000 acessos simultdneos didrios representa o
primeiro quartil da distribuicdo X.

24 E correto classificar a variavel X como uma variavel quantitativa
ordinal.

25 A mediana amostral de X ¢ igual a 3.500.

26 O coeficiente de variagdo de Pearson da distribuigéo X € superior
a 50%.

Certa empresa possui dispositivos para evitar que seu sistema de
informacio seja invadido por pessoas nfo autorizadas a acesséd-
lo. Apesar disso, para cada tentativa de invasdo, a probabilidade
de sucesso ¢ igual a 0,01. Sucesso € o evento que representa a
situagdo em que o sistema ¢é invadido. A partir dessas
informagdes, julgue os itens a seguir.

27 Considerando ntentativas independentes de invasdo, em que
n ¢ um numero fixo tal que » > 100, a probabilidade de
haver um tnico sucesso é inferior a 0,99"" '

28 Considerando que o nimero de sucessos em 500 tentativas
independentes de invasdo seja representado por uma
variavel aleatdria discreta W e que Y'=3W - 10, os valores
esperados de X e de Y sdo iguais a 5.

29 Caso o total didrio de tentativas de invasdo seja uma
varidvel aleatéria representada por uma distribuicdo de
Poisson com média igual a 100, o total didrio de sucessos
seguird uma distribuicdo de Poisson com média e desvio
padrdo iguais a 1.

30 Considerando que uma sequéncia de tentativas
independentes de invasdo ocorra, e que essas tentativas
cessem quando hé o primeiro sucesso, entdo a distribuigdo
do niimero de tentativas independentes até a ocorréncia do
primeiro sucesso seguird uma distribuigdo geométrica com
desvio padrao inferior a 95.
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Para os itens de 31 a 38, serdo consideradas como
proposi¢des apenas as sentencas declarativas, que mais facilmente séo
julgadas como verdadeiras — V — ou falsas — F —, deixando de
lado as sentengas interrogativas, exclamativas, imperativas e outras.
As proposigdes serdo representadas por letras maidsculas do alfabeto:
A, B, C etc. Para a formagfio de novas proposicdes, denominadas
proposigdes compostas, a partir de outras, usam-se os conectivos “e”,
“ou”, “se ..., entdo” e “se e somente se”, ¢ 0 modificador “nfo0”, ou
“ndo é verdade que”, simbolizados, respectivamente, por: A\, V, =, <>
e —. Dessa forma, AAB € lido como “A e B”; AVB € lido como “A ou
B”; A—B € lido como “se A, entdo B”; A <> B é lido como “A se ¢
somente se B”, significando, nesse caso, que A—~B e B—A; ~A élido
como “ndo A”. Uma proposigdo é simples quando, em sua formulag@o,
ndo se emprega nenhum dos conectivos.

A cada proposigdo supde-se associado um dos julgamentos
V ou F, que se excluem. Para associar esses valores V ou F as
proposi¢des compostas, sdo usadas como critério as tabelas-verdades,
COmo a seguir.

T
\Y \Y%

\ Vv \Y \Y F
Vv F F \' F F F
F \% F \4 \% F \%
F F F F \4 \4 \4

As proposi¢des em que atabela-verdade contém apenas V sdo
denominadas tautologias, ou logicamente verdadeiras. Se a tabela-
verdade contiver apenas F, a proposi¢do é logicamente falsa.

Duas proposi¢cdes A e B s@io equivalentes se suas tabelas-
verdades forem iguais.

Tendo como referéncia as informagdes apresentadas, julgue os itens
seguintes.

31 A proposi¢do “Néo precisa mais capturar nem digitar o codigo de
barras” pode ser, simbolicamente, escrita como AAB, em que
A ¢ a proposigio “Nao precisa mais capturar o codigo de barras”
¢ B é a proposicao “Nao precisa mais digitar o cédigo de barras”.
32 Asproposic¢des “Nao precisa mais capturar nem digitar o codigo

de barras” e “N&o precisa mais capturar ou digitar o codigo de
barras” sdo equivalentes.

33 Considerando todas as possibilidades de julgamento V ou F das
proposi¢des simples que formam a proposicdo “Se Pedro for
aprovado no concurso, entdo ele comprara uma bicicleta”, ¢
correto afirmar que ha apenas uma possibilidade de essa
proposigéo ser verdadeira.

34 Considerando todas as possibilidades de julgamento V ou F das
proposi¢des simples que formam a proposi¢do “O SERPRO
processara as folhas de pagamento se e somente se seus
servidores estiverem treinados para isso”, € correto afirmar que
ha apenas uma possibilidade de essa proposi¢do ser julgada
como V.

35 As proposi¢des AAB—AVB e AVB—A/AB sdo, ambas,
tautologias.

—1

X
36 Considere M = [
1 x

i| uma matriz em que x pode assumir

qualquer valor real. Nesse caso, ¢ correto afirmar que a
proposi¢do “Para algum nimero real x, a matriz M nZo serad
inversivel” € uma proposi¢fo verdadeira.

37 Considere a seguinte proposi¢do: “x, y e z sfo numeros reais
tais que x + y + z =1 e 2x + y + z = 0”. Nesse caso, se
essa proposicdo for V, entdo serd V também a seguinte
proposicdo: “x=-1ey+z=2".
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Uma afirmagio formada por um nimero finito de proposi¢des
Ay, A, ..., A,, que tem como consequéncia outra proposigdo, B, é

denominada argumento. As proposigdes A, A,, ..., A, sdo as

H
premissas, ¢ B é a conclusdo.

Se, em um argumento, a conclusio for verdadeira sempre que
todas as premissas forem verdadeiras, entdo o argumento ¢

denominado argumento valido.
Tendo como base essas informagdes, julgue o item abaixo.
38 O argumento formado pelas premissas

A, A, A=A A, A= A~ A, e pela concluséo
B = A,AA, ¢ valido.

Os diagramas logicos, também denominados diagramas de Euler-
Venn, sdo utilizados como auxiliares na solugdo de problemas

envolvendo conjuntos. Sdo trés os diagramas basicos.

: indica que um conjunto esta
estritamente contido em outro.

: 0s conjuntos tém alguns
elementos em comum,
mas nao todos.

: nao ha elementos comuns
entre os conjuntos.

Com base nessas informagdes, julgue os itens a seguir.

39 Considere os conjuntos dos politicos, dos advogados e dos
catdlicos. Nesse caso, o diagrama seguinte pode ser usado para

descrever a relagfo entre esses conjuntos.

40 No Brasil, a relagdo entre eleitores, analfabetos e juizes pode ser

representada pelo seguinte diagrama.

RASCUNHO
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This text refers to items from 41 to 50

1

10

13

16

19

22

25

The Capability Maturity Model (CMM) and the more
recent CMM Integrated have initiated a new discipline of
engineering management that plays a dominant role in software
practice and research. The literature offers a number of successful
cases of how software firms adopted these models and the CMMs
do indeed offer many useful recommendations for how to
systematically assess and improve software operations. The
CMMs are, however, rooted in the ideal of a rational, control-
centered culture for software development, and although other
software process improvement (SPI) approaches have been
suggested, they do not differ from the CMMs when it comes to
underlying values. It is therefore not surprising that most software
firms struggle to take advantage of the potential benefits of SP1 as
they adopt this technology into the complex and dynamic realities
of their day-to-day operations.

For small software firms, it is particularly challenging to
adopt SPI technology because the dominating approaches to SPI
target large organizations; there are few resources available for
improvement in small software firms; it is by no means trivial
tailoring SPI knowledge to their needs; and, because it normally
takes several complex and expensive initiatives to reach new
maturity levels. These challenges combined with sensitivity to
highly dynamic environments require small software firms to seek
alternative approaches to exploit the potential benefits of SPI
technology.

Internet: <www.palgrave-journals.com> (adapted)

According to the text it is correct to assert that

41 the Capability Maturity Model is likely to become the most
recent integrated discipline of engineering management.

42 software firms have adopted CMMs successfully.

43 SPI technology is particularly suitable for small software

firms.

44 the CMMs are quite unlike other software process

improvement approaches in terms of their basic values.

Based on the linguistic structures of the text, judge the
following items.

45  “indeed” ({.6) can be correctly replaced by in addition to.
46 “although” (£.9) is synonymous with even though.

471 “struggle” (0.13) means to make a determined effort.

48 “by no means” (£.19) is the same as otherwise.

49 the verb to tailor (0.20) is synonymous with to adapt.

50 “seek” (0.23) can be correctly replaced by mix.

RASCUNHO
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A dindmica que sustenta os processos projetual e tedrico
da atividade do design é embasada na dialética da forma e da
fun¢lio, que se expressa nas qualidades de beleza e eficiéncia.
Assim, um objeto qualquer de design, seja ele um produto industrial
ou uma pega de comunicagdo visual, para ser completo, deve ser
bonito e funcionar bem. Interessantemente, funcionar bem ¢
também uma forma de beleza, considerando que o mau
funcionamento de um objeto € algo que incomoda e interfere
negativamente na producdo, nos processos € nas pessoas.

Eficiéncia, bom funcionamento e precisdo isoladamente
néo garantem a determinado produto ou pega de comunicagéo o seu
completo desempenho; design é, antes de qualquer coisa, uma
forma de arte que apresenta os aspectos estéticos, plasticos e
gréaficos de um produto, que, para ser bom, deve funcionar bem, ser
bonito e agradével.

Beleza relaciona-se com o apelo sensorial dos objetos e
das imagens e tem por fung@o chamar a ateng@o das pessoas por
meio de um processo de comunicagdo visual em que qualidades
formais, simbolicas, performdticas e informativas interagem.

Tendo como referéncia o texto acima, e considerando a
multiplicidade de aspectos que ele evoca, julgue os itens a seguir.

51 Eficiéncia e beleza sdo igualmente importantes no design.
52 Para ser cult, um produto grafico ndo deve ser funcional.

§3 O projeto grafico de um livro a respeito de sistemas
computacionais ndo deve ter necessariamente preocupagio
com a estética.

54 Em um cartaz de divulgag¢do de um espetdculo musical, as
qualidades estéticas e funcionais devem estar harmonizadas.

55 Na tipografia, disciplina fundamental do design gréfico,
atributos como legibilidade, conforto de leitura e visibilidade
estdo diretamente relacionados a aspectos estéticos do design.

56 O campo do design relacionado a arquitetura de informagéo
objetiva promover maior acessibilidade aos usuarios da rede
mundial de computadores em geral, em uma clara manifestagéo
do carater funcionalista do design.

O design grafico, também denominado programag@o
visual, é uma atividade de design associada a comunicagéo social,
que se manifesta na forma visual e, as vezes, audiovisual. A
dialética da forma e fungdo define também a atividade do design
grafico. Entretanto, como manifestagédo da comunicagéo, o design
grafico estd impregnado de elementos especificos que o distinguem
das demais atividades do design, fruto da unido da semantica e da
estética, ou seja, da unido da palavra e da imagem. Para se
estabelecer umarelagdo legitima de comunicagdo visual pelo design
grafico, trés principios sdo fundamentais: informar, identificar e
persuadir.

E importante ressaltar o carater onipresente desses
principios, pois eles coexistem, em maior ou menor grau, em toda
e qualquer peca de comunicaco visual, variando de acordo com o
tema e a natureza de cada projeto.

Tendo o texto acima como referéncia inicial, julgue os itens de
57 a 65, relativos aos fundamentos do design grafico.

57 Considerando os trés principios citados no texto, € correto
afirmar que informar constitui elemento primordial na
elaboragiio de um infografico para um jornal diario.

58 Um calendario de cardter publicitdrio tem a fungfo principal de
identificar o patrocinador.

59 A persuasfio ¢ uma forma licita de ludibriar o leitor de uma
peca grafica.

60 Em um livro essencialmente de texto, ou em um livro
composto de imagens, o design grafico deve-se basear no
conceito de invisibilidade, ou seja, de que o design deve deixar
transparecer o conteudo da publicagdo.

61 As ilustragdes, de modo geral, possuem carater estritamente
persuasivo.

62 O rotulo de um produto na géndola de um supermercado deve
conter, de forma equilibrada, os trés principios fundamentais
do design, pois ele identifica o produto, fornece informagdes
diversas e seduz o consumidor.

63 Texto e imagem sdio componentes fundamentais & pratica do
design gréfico.

64 O cartaz, seja ele publicitario, social ou cultural, apesar de ser
uma importante peca grafica de comunicacdo visual, nio
permite grande expressividade grafica pelo uso da imagem.

66 O termo design grafico refere-se & profissdo dos
comunicadores visuais, também denominada de programagio
visual, em que a palavra grafico tem o significado primordial
associado a arte de reproduzir por tipografia, gravura e
estereotipia, entre outros meios.

Os conceitos de design grafico sfo colocados a prova no exercicio
cotidiano do designer grafico, em que um conjunto de habilidades
¢ necessario para a pratica profissional, entre elas o desenho, a
fotografia, a reproducéio grafica, os sistemas de cor, a tipografia e
a composi¢do visual. Com relagdo aos elementos envolvidos no
exercicio cotidiano do design grafico, julgue os itens subsequentes.

66 As cores primarias aditivas sdo o vermelho, o verde e o azul,
e servem de base ao sistema RGB utilizado nos monitores e
televisores.

67 As cores ciano, magenta e amarelo sdo denominadas de cores
primadrias subtrativas porque sdo obtidas a partir da retirada de
um dos filtros das cores aditivas.

68 A linguagem visual no design editorial de uma publicagédo
impressa ¢ a mesma que em uma publicagéo na Internet.

69 No Brasil, os cartazes sfo comumente impressos em meia-
folha do formato BB, ou seja, em folhas de papel de
48 ¢cm x 66 cm.

70  Aplicativos graficos como o Adobe Illustrator sdo apropriados
para a elaboragéo de publicagdes como livros e livretos.

71 Uma imagem de tom continuo, como uma foto em
preto-e-branco, é reproduzida na impressdo ofsete pelo uso de
reticulas de meio-tom.
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Com referéncia aos cartazes acima, julgue os itens a seguir.

72 O cartaz da figura II caracteriza-se por um design tipografico que harmoniza expressividade e legibilidade.
73 No cartaz II1, a tipografia manual e a ilustragdo interagem de forma expressiva.

74 Dacomposigdo simétrica e centralizada do cartaz IV e da leitura de seus elementos visuais, é correto afirmar que o objetivo principal
do cartaz é evidenciar o destino da viagem transatlantica.

75 Emtodos os cartazes, a ilustragio tem uma fungdo protagonista no leiaute, e a tipografia ¢ predominantemente de carater informativo.

-7 -
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O uso de software livre incorporou ao vocabulario dos designers e profissionais das artes graficas novas extensdes de arquivos.
Considerando os sofiwares livres GIMP, Inkscape e Scribus, julgue os proximos itens.

76 A extensdo de arquivo .svg (scalable vector graphics) é usada para publicar imagens vetoriais na web.

771 O software GIMP ndo salva vetores como arquivos .svg.

78 O Inkscape gera arquivos com extensdo .svg, o que permite o intercdmbio de objetos com o GIMP.

79 A extensdo de arquivo .sht € a mais indicada para salvar imagens que serdo utilizadas em uma diagramagio de pagina no Scribus.

I II 111 IV

Em relacdo as figuras acima ¢ ao uso de comandos e ferramentas do software livre Inkscape, julgue os seguintes itens.

80 A figura I, que representa a unifio entre um quadrado e uma circunferéncia, pode ser obtida utilizando-se o comando path>union
apos a selegdo dos dois objetos.

81 A figura Il pode ser obtida utilizando-se os comandos Path>Combine, Path>Difference ou ainda o Path>Exclusion.

82 A figura III pode ser obtida utilizando-se o comando Path>Intersection.

83 Para apresentar o efeito blur, a figura IV precisa ser convertida em bitmap por meio do comando Path>Trace bitmap.

i

ipanity, %

Considerando a figura acima apresentada, julgue os itens a seguir, referentes ao sofiware Inkscape.

84 A cor aplicada a um objeto, composta de 50% de C, 100% de M, 0 % de Y ¢ 0% de K, corresponde a uma tonalidade entre o azul
€ 0 magenta.

85 No campo Blur, é possivel configurar o esfumagado nas bordas de uma figura.

86 Alpha e Opacity possuem a mesma fungfo de tornar um objeto transparente.
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Considerando a figura acima, em que os espagos retangulares em
branco presentes no menu do sofiware GIMP formam a sequéncia
image>mode>decompose, julgue os itens subsequentes.

87 A opg¢do decompose permite extrair os canais de uma imagem,
incluindo a opgdo CMYK.
88 A decomposi¢do da imagem gera telas coloridas.

89 Cada uma das telas originadas no Decompose>CMYK
corresponde a um canal de cor em RGB.

Com referéncia & imagem acima apresentada, que mostra uma
janela do GIMP, e a esse sofiware, julgue os itens de 90 a 93.

90 A figura acima mostra a fusdio de duas imagens. E possivel
alcangar esse resultado por meio do comando menu
Filter>Combine>Depth merge.

91 No GIMP, foi possivel conseguir a fusdo das imagens

utilizando o comando Calculations.

92 A imagem apresentada ndo deve ser utilizada em um sitio, ja
que as suas dimensdes, assim como o tamanho do arquivo, sdo

maiores que as comumente utilizadas na Web.

93 Antes de salvar a versdo final da imagem, ¢ necessario unir as
duas camadas que a compdem por meio do comando

Layer>Flatten image.

Para diagramar um documento, uma revista ou mesmo um livro,
uma opgdo em software livre reconhecida pelos profissionais de
design gréafico € o Scribus, também conhecido como scribus open
source desktop publishing. A respeito desse software, julgue os

itens que se seguem.

94  S&o conhecidos como desktop publishing (DTP) os softwares
que possuem ferramentas para organizagdo de textos, que
dialogam com sofiware de tratamento de imagem e
principalmente que oferecem opgdes de saida e finalizagdo de

arquivos.

95 Formularios, livros e textos trabalhados no Scribus podem ser

convertidos em arquivos .pdf.

96 A linguagem JavaScript é importante para configuragdo de

formulérios criados no Scribus e que serdo publicados na web.

97 A criacfo de uma pagina mestra ¢ importante para que as
caracteristicas gerais do documento possam ser definidas para
toda a sua extensdo. Apesar disso, no Scribus ¢ impossivel

converter uma pagina qualquer em péagina mestra.

Uma institui¢@o disponibilizou em 1998 uma série de formularios
online para seus clientes. Considerando que esses formularios ainda
sejam atuais, julgue os itens a seguir, que abordam as dificuldades

para baixa-los pela Internet.

98 Um arquivo com a extensdo .tif ndo seria o mais indicado, pois
ele armazena grande quantidade de informag&o, e o tamanho
do arquivo aumentaria o tempo de transferéncia dessas

informagdes na rede.

99 Devido a largura de banda disponivel em 1998, de 14 Kbps,
para a maioria da populagdo, os arquivos feitos em software de
diagramagdo podiam ser facilmente acessados e modificados

pelos usuarios.

100 A extensdo .ps ndo deveria ser utilizada pelo grande publico,
pois essa extensdo, ainda hoje, requer sofiware especificos,

disponiveis apenas em gréficas, editoras e locais similares.
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Ferramenta de fontes
Typekit
Tipografia online, finalmente.

Os designers ha muito reclamam do estado da tipografia
na Web. E eles estfio certos, afinal de contas € muito limitador
contar com apenas um punhado de fontes de sistema comuns a
todos.

Felizmente a adog¢do da tag @font-face entre os
navegadores atuais e a chegada do Typekit prometem mudar a
situagdo.

O Typekit hospeda as fontes em seus servidores, e 0s
associados carregam os arquivos com um simples cddigo em
JavaScript. Entdo € possivel trabalhar com novas fontes
normalmente, com a diferenga de que ha centenas de opgdes além
das fontes padrdo. O problema é o mesmo de sempre: o suporte €
implementagdo da tag @jfont-face ainda engatinha. E, como o
Typekit ainda € novo, hd algumas questdes técnicas que precisam
ser resolvidas. O futuro, entretanto, parece ser brilhante. Logo a
tipografia na Web serd linda e editavel.

Revista www.com.br, ano 10, n° 117, ed. Europa,
abr./2010, p. 82 (com adaptagdes).

Tendo como referéncia o texto acima e a multiplicidade de aspectos
que ele evoca, julgue os itens a seguir.

101 Existem tags CSS que garantem que uma fonte possa ser
escolhida dentro de um conjunto esperado, utilizando fontes de
sistemas e fontes mais utilizadas. Embora essa solugéo nfo seja
ideal, ela permite que a troca de fonte em computadores
remotos seja controlavel e o leiaute de uma pagina web ndo
seja totalmente destruido.

102 O designer que adotar imediatamente o uso da tag descrita no
texto pode produzir um sitio ndo acessivel uma vez que o ndo
reconhecimento do comando por todos os navegadores
impediria a exibi¢do da fonte e, portanto, do texto.

103 Até a invengdo do Typekit, ndo existia nenhuma possibilidade
de hospedar fontes na Web.

O autor Jakob Nielsen desenvolve ha mais de uma década estudos
sistematicos acerca de navegabilidade, acessibilidade e usabilidade
na web. Considerando o pensamento de Jakob Nielsen a respeito de
usabilidade, julgue os préximos itens.

104 A capacidade de navegacdo em um sitio € importante para a
usabilidade, sendo que as agdes de buscar e localizar sdo
responsaveis por mais de um ter¢co das dificuldades dos
usuarios.

106 Localizabilidade, design de pégina, informagdo, suporte a
tarefas e design espalhafatoso sdo itens que podem interferir na
acessibilidade de uma pagina web, ao contrario dos bugs.

106 A férmula elaborada para calcular o placar total de problemas
de usabilidade ¢ representada pela expressio
TFP x TI x /TP /410, em que TFP, TI e TP correspondem,
respectivamente, a taxa de frequéncia do problema, taxa de
impacto e taxa de persisténcia.

107 Com relagdo a tipografia e legibilidade, o tamanho de texto
recomendado para o publico em geral € de 12 a 14 pixels.

Acerca da elaboragdio de uma pagina web, julgue os itens
subsequentes.

108 Um leiaute de pagina web em tabela ¢ mais leve e mais
acessivel do que em CSS.

109 HTML, CSS, SVG e XML sfo linguagens e extensdes
denominadas web standards.

110 O sistema hexadecimal de cores ¢ a converséo de cores de luz
RGB em cores de impressio CMYK e se expressa por
combinagdes de dois digitos, letras e numeros, para cada uma
das cores basicas que compde uma cor.

111 Ao criar-se um arquivo CSS, é possivel declarar nele as
principais caracteristicas de uma pagina e chamar cada um dos
estilos definidos no codigo HTML.

O W3C — Consorcio World Wide Web — ¢ uma comunidade
internacional que desenvolve padrdes paraa WWW com o objetivo
de garantir o crescimento da Web. Considerando os padrdes do
W3C, julgue os itens que se seguem.

112 A principal fungdo da WAI (web accessibility initiative) ¢
tornar a Web acessivel para as pessoas com deficiéncia.

113 Para a avaliacio de acessibilidade de sitios na Web, o0 W3C
disponibiliza em sua pagina um formulario no qual se pode
digitar o enderego-teste de um sitio e, apds aguardar alguns
instantes, obter um relatério de acessibilidade € um selo de
sitio acessivel.

114 A extensdo de arquivo .svg, gerada em software como o
Inkscape, é indicada pelo W3C para publicago de vetores na
Web.

115 Gréficos, codigo HTML e animagdes em .swf estdo entre os
padrdes indicados para web design.

Poder usar a voz em computadores € mais especificamente na web
¢ o sonho de muitos. Recentemente, Alfred Spector, pesquisador do
Google, declarou que estdo nascendo no Google Labs sistemas de
busca por voz. Segundo ele, a voz é um dos maiores desafios
tecnoldgicos em ciéncia da computagfo. Entretanto, para algumas
pessoas, mais que desafio tecnologico, a possibilidade de traduzir
um texto visual em som ¢ a unica forma de ter acesso aos conteudos
publicados na Internet. Com referéncia a essas informagdes e a
leitores de tela, julgue os itens a seguir.

116 Um leitor de tela funciona traduzindo textos e imagens em
som.

117 Considerando-se todas as informag¢des necessarias, a adogdo
dos pardmetros de HTML e CSS e a elaboragio do script das
paginas permitem melhor identificagdo dos elementos e
facilitam o trabalho de um leitor de tela. Um exemplo disso ¢
0 uso da tag <i_mag alt= “breve descrigdo da
imagem”>.

118 Atualmente, o sistema IBM Via Voice € o0 tinico leitor de tela
em portugués disponivel para deficientes visuais.

119 Um leitor de tela que traduza os textos com a voz mais
proximo da humana, evitando efeitos robdticos, diminui o
estresse do usudrio.

120 Um exemplo de uso de rag correto e sua interpretagdo pelos
leitores de tela sdo as tags <b> e <strong>. Embora ambas
produzam como efeito visual uma letra em negrito, a tag
strongacompanhada da codificagdo vocs #7869 significaler
com mais for¢a ou énfase.
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